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Preface

Overview

u-center is u-blox’ powerful GPS evaluation and visualization tool which can be downloaded free-of-charge from
our website (www.u-blox.com). This user’s guide provides a description of the features of this software. It allows
end users to assess and test u-blox GPS receivers for navigation and positioning performance.

The purpose of u-center is to enable users to:
Conduct performance tests on u-blox and other GPS receivers.
Configure u-blox GPS receivers.

Access and download Firmware updates.
Test the added performance provided by u-blox’ free AssistNow A-GPS service.

Using this Guide
This guide assumes, the user has basic computer skills and is familiar with the Windows Graphical User Interface
(GUI) and GPS receiver environments.

The following symbols are used to highlight important information:

& An index finger points out key information pertaining to integration and performance.

& A warning symbol indicates actions that could negatively impact or damage the receiver.

Technical Support

If you have questions about installing or using u-center please:

Read this user’s guide carefully.

Check our homepage (http://www.u-blox.com) to ensure that your GPS receiver, firmware and the u-center
software are the latest versions.

Refer to our web based information service and database of Frequently Asked Questions (FAQ).
Worldwide Web
Our website (www.u-blox.com) is a rich pool of information. Product information, technical documents and
helpful FAQ can be accessed 24h a day.
By E-mail

If you have technical problems or cannot find the required information in the provided documents, contact the
nearest of the Technical Support offices by email. Use our service pool email addresses rather than any personal
email address of our staff. This makes sure that your request is processed as soon as possible. You will find the
contact details at the end of the document.

Helpful Information when Contacting Technical Support
When contacting Technical Support please have the following information ready:
Receiver type (e.g. LEA-5H), firmware version (e.g. V6.00), and u-center release (e.g. u-center 5.07)

Receiver configuration and short description of the application
Your complete contact details

GPS-SW-08007-A Released Preface
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1 Features

u-center evaluation software provides system integrators and end users with a quick and simple way to interface
with u-blox GPS chipsets, modules and boards. It enables easy evaluation, performance testing, development
and debugging of GPS receivers. u-center allows easy connection to u-blox products and provides a suite of
features to view, log, and analyze performance. The features include:

Support for u-blox’ latest receivers using u-blox 5 positioning technology. u-center can communicate with
these receivers using either the UBX protocol, or the NMEA-0183 standard protocol.
Support for receivers that utilize standard NMEA strings.

u-center presents all the information collected during the operation of the GPS receiver. All aspects of GPS
data (position, velocity, time, satellite tracking, etc.) can be monitored and logged under various test
scenarios for the evaluation of a receiver. u-center software allows analysis of the collected data in order to
investigate performance issues such as accuracy, road test position and trajectory, satellite tracking, time to
first fix, etc. All processed data can be captured in ASCII format and ported into popular spreadsheets for
creating additional plots and statistics.

Camera View: photographic data can be stored in the log file together with the navigation data and later be
replayed in the application.

Export data files to Google Earth and Google Maps.
Supports AssistNow Online and AssistNow Offline.

Data recording and playback function.

Structural and graphical data visualization in realtime.

Cut and paste export to standard PC application software.

Docking views (real-time cockpit instruments):
Satellite constellation, compass, clock, altimeter, speedometer, GPS and satellite information views.

Download firmware updates into GPS receivers

GPS-SW-08007-A Released Features
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2 Getting Started

2.1 General Information about displayed values

e Longitude and latitude are displayed according to the datum selected in the GPS receiver (usually: WGS-84).
o Time is displayed with reference to UTC

o Elevation is displayed with reference to either MSL (Height above mean sea level or Orthometric Height) or
to HAE (Height above WGS-84-Ellipsoid). The reference is controlled by the GPS configuration.

2.2 Connecting a GPS Receiver to the PC

This section assumes that you have purchased a u-blox 5 Evaluation Kit. Should you try to connect a GPS receiver
to a PC without using the EvalKit, make sure you use appropriate RS-232 level shifters. Connect a serial cable
between a communications port (COM-port) of a PC and the EvalKit.

2.3 Installing u-center
The u-setup installation program guides you through the necessary steps for a successful program installation.

& u-center uses dynamic link libraries (DLL). The installation program will automatically install the
required DLL's into the u-center program directory. Should you try to copy a u-center
installation from one location to another after the installation, make sure you copy the DLL files
as well.

After a successful installation, u-center will start up as shown in Figure 1:

Fée Ef W Playse Racome Toos Window Hel
DR - L LEE AahARDEDO-E-E-M-EFf aO0REEOMAER
v 2 W0 e e e — #H | Ml 288 |

Figure 1: Start Display

GPS-SW-08007-A Released Getting Started
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2.4 Configuring the Serial Connection

u-center stores the serial settings and uses the last configuration when started. When u-center is started for the
first time, the COM port needs to be initialized. This is typically done in the Receiver Tool Bar (Figure 2).

IO - N -

"
Figure 2: Receiver Tool Bar

I
Connect/Disconnect-Button with COM-Port selection arrow

Baudrate-Button with baudrate selection arrow

Autobauding-Button

& u-center only supports the COM-Settings listed below. All u-blox GPS receivers are pre-configured this
way.
Parity: None
Data Bits: 8
Stop Bits: 1
Flow Control: none

2.4.1 COM-Port

a0 . oanr - | g Press the arrow in the Connect/Disconnect-Button and select the used COM-Port

* Dizconnect

COM 1
COM 2
COM 5
COM 5
COM 7
COM &

2.4.2 Baudrate

2.4.2.1 Manual Selection
& Does not apply to USB.

J.@. -] |J The baudrate can be manually set or automatically detected by using the autobauding

e feature. Press the arrow in the Baudrate-Button to manually select the baudrate.

2'400
4'800°
2600

As soon as u-center is synchronized to the GPS receiver, the Connect/Disconnect-Button on
the Receiver Tool Bar changes the color to green (Figure 3) and the display shows

o information about the satellite constellation, signal to noise ratio, time etc (Figure 5). If the
38400 baudrate of u-center and GPS receiver are not set to the same value, the “Communication
» 57600 Information” icon changes to red. Please refer to section 4 for further information.

115200

J-I-vJ'LI'le B

Figure 3: COM-Port and Baudrate successfully detected

GPS-SW-08007-A Released Getting Started
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2.4.2.2 Autobauding

u-center support autobauding. If frequent break errors are detected, u-center will lower the baudrate, in case of
framing errors, the baudrate is increased until no further errors are detected.

i

T

Figure 4 Autobauding Button

& Some serial cards or adapters frequently generate errors. The u-center autobauding may not
work reliably in this case. If you experience frequent errors, please set the baudrate manually.

If the GPS receiver is working correctly, the display will show information about the satellite constellation, signal
to noise ratio, time etc (Figure 5)

Fin Edt Wew Payec Recsw Took Window ten
ODE&E- -4 e daaa @20 E]D-H-.vl-.ﬂ....p.'qg.g
w2 W@ e f—————————————— il B S| s

Ready - COMLT 5600 bk S No fie cpen r-3 00i19:31 De:3Ede [

Figure 5: Start Display after a successful connection

GPS-SW-08007-A Released Getting Started
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3 Concept and Philosophy

Understanding the basic concept behind u-center is important in order to get the highest benefit out of this
powerful GPS evaluation software. Figure 6 depicts the architecture of the software. The program gets a data
stream either from a COM port or a logfile and splits this stream into protocol messages. From the messages,
relevant parameters are extracted and inserted into the current dataset of the database.

In the current dataset statistical values of the parameters are calculated. Average, Minimum, Maximum and
Standard Deviation are calculated for most parameters. If a protocol does not provide a parameter, u-center tries
to calculate the parameter from the ones that are available. For Example if velocity-north and velocity-east are
available, u-center calculates the Speed over Ground and Course over Ground, unless this data is already
available in the protocol.

Calculate
Parameters
from other
Parameters Table Views
Graphical Views
Docking Views
Protocol N
Data Message ) Parameter ﬁ
—> N
Source Parser Extracter Database &, .L
.
LogFile.ubx -
Console Views
Calculate Message View
StatiStiCS 12:00:01 24 47 50 56 54 47
2C 30 2E 30 30 2C
—> TiEes
Data Stream 12:00:02 24 47 50 56 54 47
—> Messages >

9 Parameters

24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 00

Figure 6: Engine Architecture

When a new epoch (change in time) is detected, the current dataset is stored as history in the database. This
history has a limited size. If the Size is exceeded u-center keeps only the latest datasets and the oldest ones are
removed. The history size may be adjusted. Refer to section 3.2.5 for the details

u-center provides various view classes for observation. Most of the views take their data from the database. But
there are some views, which get their data directly from the message without using the database at all. The
other views are updated when the database changes.

Message View Displays a copy of every known message. This view allows observing a single message in
detail. It may also be used to send and configure the GPS receiver.

Console Views Display the messages in text form. They are particularly useful for users to develop GPS
firmware code. There is also a wide range of information available, which is useful for evaluation and
testing.

GPS-SW-08007-A Released Concept and Philosophy
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Graphical Views Display parameters from the database in graphical form. Charts, Histograms and even a
Map Overlay can be created. There are two more views (Deviation View, Sky View) that may be used for
statistical performance and antenna pattern analysis.

Tabular Views Show the parameters of the database in tabular form. They can be freely configured to
allow customized tables.

Docking Windows Can be docked to the frame of u-center. An analog watch, compass, world map,
altitude and speed meter are available. There are also docking windows showing the current signal power
and the constellation of the satellites received by the GPS receiver as well as a summary of the GPS status.

& Displaying various Views and Docking Windows requires lots of computing power. Minimizing or closing
them may significantly reduce the CPU usage.

3.1 Color coding scheme

In the graphical views and some of the docking windows, colors are used to indicate the quality of the data.
Table 1 depicts the color-coding scheme parameters for graphical views depending on the quality of the
navigation solution.

Color Meaning

Yellow Current value

Green 3D navigation solution

Cyan 2D navigation solution
4 Blue Degraded navigation solution (e.g. Dead reckoning)
4 Red No navigation solution

Table 1: Color-coding scheme for graphical views

Table 2 depicts the color-coding scheme for the Docking Windows and Sky View. It indicates the state of each
satellite.

Color Meaning

Green | Satellite used in navigation

Cyan Satellite signal available, available for use in navigation

@ Blue | Satellite signal available, not available for use in navigation

@ Red Satellite signal not available

Table 2: Color-coding scheme for the Docking Windows and Sky View

GPS-SW-08007-A Released Concept and Philosophy
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3.2 Operating Modes

u-center has different operating modes. The mode changes when you open or close a log file or when you make
an action in the player. To be able to use the record mode you have to create a new file, save to a new file or
open an existing file. The record and player mode are only available if you have created a new file or when you
have opened a write-able file.

»| Recorder

Open/Create
File

Stop

Online
Mode

Mode
Close/Eject Play/Step/ Scan
File

Figure 7: Relations between operating modes

3.2.1 Online Mode

In this mode a GPS receiver is directly connected to u-center via a serial port with. u-center can control and
configure the receiver, it will display the data that the receiver is sending periodically.

>
Database .- o
N
SRSt

12:00:01 24 47 50 56 54 47|
2C 30 2E 30 30 2C|
54 2C 2C 4D 2C 30|

2E 30 30 30 2C 4E]|
12:00:02 24 47 50 56 54 47|
2C

2C 4B 2C 4E 2A 33|

Figure 8: Dataflow in Online Mode

3.2.2 Stop Mode

In this mode no data from receiver or log file is forwarded to the database and views. u-center is in this mode
when a log file is open but player and recorder are not active.

GPS-SW-08007-A Released Concept and Philosophy
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3.2.3 Record Mode

u-center - User’s Guide

Record Mode is the same mode as the Online Mode. But u-center additionally creates a log file on your disk,
contacting all the messages sent by the receiver. You enter this mode by creating a new log file or opening an
existing log file without write protection and pressing the record button. An example of using this mode would
be to make overnight measurements and evaluate the data at a later time. u-blox customer support may request
a log file from you when you are experiencing a problem with one of our receivers.

@

Figure 9: Dataflow in Record Mode

3.2.4 Player Mode

LogFile.ubx

>
Database

12:00:01 24 47 50 56 54 47

2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30

2C 4B 2C 4E 2A 33

The Player Mode allows replaying a previously recorded log file step by step, in real-time or at an accelerated
rate. You enter this mode by opening a file and pressing the play, step or scan button.

>

LogFile.ubx Database

Figure 10: Dataflow in Player Mode

GPS-SW-08007-A

12:00:01 24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 4E|
12:00:02 24 47 50 56 54 47
2C 30 2E 30 30 2C|
54 2C 2C 4D 2C 30
2E 30 30 30 2C 4E|
2C 30 2E 30 30 30
2C 4B 2C 4E 2A 33|
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3.2.5 Database Limitation

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of large log files. The
limit is set to 1800 epochs by default. This means if an epoch is available every second you can analyze data for
up to 30 minutes. After this time the oldest values are discarded. Data stored to a log file is not affected by the
database limitation. The number of epochs displayed in u-center can be reset through the menu bar as follows:

File Edit WYew Player Receiver ‘Window  Help

D u D’* . | é &| ‘X’ % F?rmwareUpdateAntaris‘.. ] | = . | . - . - . | - = ||E|.|-|E|-|E|‘E||
Firrnware Update u-blaxs...

SR I | ’.‘-'( A m | | Dump Receiver Diagnastics. .. =3 IH ﬂw uc [E| @
Assisthow Offline. .,
GPS Configuration. ..

Preferences

Generic |Wolkspace| Colors | Meszagebox

Senial ports

W Automatically [disjconnect if most recently uzed serial port [dislappears.

W Enumerate serial ports [this may slow down menus).

M aximum number of zerial ports 255;I

Fower b anagement

& Mone ¢ Deny suspend if connected " Diszornect on suspend

Frogram Options [requires restart]

Database

b a=imurn number of epochs = 00:30:00 at 1Hz rate

(u] 4 I Catcel | Apply |

& For long-term observations, it's recommended to start recording a log file before analysis begins.

& If a high value of epochs is selected, the display of data in real-time cannot be guaranteed,
especially when graphical views are open.

3.2.6 Relations between Modes

The operating mode depends on the status of the log file player. Modes are changed by user actions. Each mode
has different states that are changed by a user action or by an event (Figure 7).

In the Online and Record modes, u-center displays data from the receiver. In Player mode data from a log file
is displayed. Player mode has different states. In Play state messages are read and displayed periodically from the
log file. The very intuitive user interface is derived from that of a CD player. u-center updates the views after
each message. Step state only gets one message from the log file and immediately returns to paused Play state.
Scan state also reads messages periodically but the display is only updated when paused or by changing the
state. Position can be set in a log file. This behaves differently in the Player and Stop modes. In Stop mode the
position is just set and no data is read and displayed. u-center will start recording or playing from that position
when changing the mode. If position is set in Player mode, u-center will load the data up to this position from
the log file and display the contents.

GPS-SW-08007-A Released Concept and Philosophy
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4 Menu Structure

4.1 Main Frame

The Main Frame is the primary display screen of u-center. It displays all tool bars and some of the information
provided by the GPS receiver. In the status bar, information about communication, UTC time, Operating Time,
used protocol (NMEA or UBX), used file, etc. is shown.

e Button Function: A description about each button in the tool bars can be obtained by holding the mouse
cursor over the button for a few seconds. A Tool Tip message will appear near the Icon with additional
information while a detailed description is displayed in the Status Display.

wu-center [Satcte Fostion]

mmmma«mhﬁ%m
DE&E- = ~am|@ammmm§
g ;.:I H i e[ w-»|k

= COMI7 9500 : 00931 edes [T 4

e

« Status Display: display the current action or the function of a button if the mouse cursor is over the button

GPS-SW-08007-A Released Menu Structure
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u-blox 5 / Antaris Mode: u-center automatically detects the type of GPS receiver connected and activates
the appropriate mode of operation in order to take optimal advantage of the features. The mode can also
be manually selected through the menu bar.

File in use: As soon as a file is used (this file must first be opened) the name of the file will be displayed
(xxxxxx.ubx)

Protocol Information: This box indicates the current message set that is being used to communicate with
the GPS receiver. This can be the NMEA-0183 standard or the UBX protocol. The UBX protocol provides
more extensive information with the receiver. u-center can handle both protocols.

Operating Time: The time elapsed since you started u-center
UTC Time: The current time sent by the GPS receiver
Communication Information: Shows the active COM port and baudrate.

Color-Coding of this icon: | &
Green: data is being received at the correct baudrate
Dark Green: the last data received was valid, but there is no data to collect at this time.
Red: data is being received but errors are detected
Dark Red: no data is being received but errors have been detected in the past
Gray: waiting for first data

|=m= COMS5 19200

Figure 11: u-center and GPS receiver are synchronized (green plug)

|4m= COMS 38400

Figure 12: u-center and GPS receiver mismatch (red plug)

4.2 Menu Bar

All u-center functions can be accessed through the Menu Bar, alternatively it may be easier to use the icons in
the tool bars.

GPS-SW-08007-A Released Menu Structure
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4.3 File Menu and Standard Tool Bar

Dz 8R|/ BE e &

Figure 13: Standard Toolbar

FI=N Edit  View Player Rece N #[: Edit  ‘iew Player Receiver Tools  Window F
P, .. CErl+r M. .. Chrl+r ) | & J :@
Save ... Chrl+5 = - Save ... Chrl+5 i
Cpen... 0 Cpen. .. Che0 | | ] | & | I »
Close &4 Close
Database Empty Database Emphy
Database Export b Database Export Gaogle Map Herl

% ] aoogle Earth Kml
Print. .. Chrl+P Prink. .. CErl+P
Prink Presigw _l— & Prink Preview
Prink Setup. - Prink SEtLIp. o
Recent Files b Recent Files
Exit Exit

=M Edit Yiew Plaver Receiver Tools ‘Window Help
e, ., Chrl+r P2 | = J :@ :@ :@ | et
Save ... Chrl+5
Cpen... I N |T w |
Close
Database Empy
Database Export »

Print. .. Chrl+P

Print Presview

Print Setup. ..
1 COMS_ref =
2 COMS_030611 142620.new = ~
JCOMIS_ 080611 154108

4 COM4_kerlink,

Figure 14: File Menu(s) with corresponding toolbar icons

New... u-center can capture receiver output data into a logfile. However, logging will only start
after Record in the Player Menu has been selected. The elapsed logging time is displayed
in the field operating time. The log files have a ‘ubx' extension.

Save... Opens a new logfile, saves the data from a ring buffer to the logfile and immediately starts
recording all newly received data. This is useful when error or an unexpected event
occurred and no log file was recorded. The size of the ring buffer (4 MB) is large enough
to retain the data for the last hour (approx.).

Open... Opens a stored log file to be replayed.

Close Closes the log file.

GPS-SW-08007-A
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Database Empty  All stored values are deleted.

Database Export  Stored u-center logfiles can be converted into HTML or KML data formats for display with
Google Map and Google Earth.

Recent Files A list of the most recent log files.
Exit Terminates u-center.

4.4 Edit Menu

The Edit Menu is fully Windows® compliant.

4.5 View Menu and Views Tool Bar

4.5.1 Text Console

The Text Console displays the content messages in textual form such as UBX-INF or NMEA messages.

E&U Text Console Q@El

§aPZ0A, 120321.00,01, 04, 2008, 00,0064
:03:22  $GPRMC, 120322.00,4,4717.14999, N,00833.95818,E,1.676,332.59,010408, , , A¥67
:03:22  $GPVTG, 332.59,T,,M,1.676,N,3.106,K,A%31
:03:22  $GPGGA,120322.00,4717.14999, N, 00833 . 95818,E,1,07,1.09,423.4,M,48.0,M, ,*52
:03:22  $GPGSA,A,3,20,23,11,17,31,13,04,,,,,,.2.03,1.08,1. 71%00
:03:22  $GPGsv,2,1,08,20,79,030,22,23,62,190,27,11,49,158, 28, 17,349, 260, 25 %78
:03:22  $GPESV, 2,2,08,31, 24,060,23,13, 24, 209, 23,04, 18, 307, 30, 32,08,078, *70
:03:22  $GPGLL,4717.14099,N,00833. 95818, E,120322.00, 4, A%ES
:03:22  $GPZDA, 120322.00,01,04, 2008,00,00%69
:03:23  $GPRMC, 120323.00,4,4717.15089,N,00833.95982,E,1.724, 336.84,010408, , , A¥6F
:03:23  $GPVTE, 336.84,T,,M,1.724,N,3.194, K, A%38
12:03:23  $GPGEA, 120323.00,4717.15089, N,00833. 95982, E,1,07,1.09,421.7,M,48.0,M, , *59
12:03:23 $GPGSA,A,3,20,23,11,17,31,13,04,,,,.,2.03,1.09,1.71%00
12:03:23 $&PGSY,2,1,08,20,79,030,22,23,62,190,27,11,49,158, 28, 17,39, 269, 2578
12:03:23  {GPGsv,2,2,08,31,24,060,23,13, 24, 209, 23,04, 18,307, 30, 32,008,078, *70
12:03:23 $GPGLL,4717.15089,N,00833.95982,E,120323.00, 4, A%6F
12:03:23  $GPZDA, 120323.00,01,04, 2008,00,00%68
12:03:24 $GPRMC, 120324.00,A,4717.15183,N,00833.96159,E,2.109,41.31,010408, , , A*59
12:03:24 $GPYTSE,41.31,T,,M,2.109,N,3. 009, K, A%03
12:03:24  $GPGGEA, 120324.00,4717.15183, N,00833.96159,E,1,07,1.09,419.9,M,48.0,M, , *50
12:03:24 $GPGSA,A,3,20,23,11,17,31,13,04,,,,,,2.03,1.09,1. 71%00
12:03:24 $&PGSY,2,1,08,20,79,030,21,23,62,190,27,11,49,158,29, 17,39, 269, 24*7B
1z:03:24 $GPGSV,2,2,08,31,24,060,23,13,24, 209, 23,04, 18, 307,31, 32,008,078, *71
12:03:24 $GPGLL,4717.15183,N,00833.96159,E,120324.00, 4, A%GE
12:03:24 $GPZDA, 120324.00,01,04, 2008,00,00%6F
12:03:25 $GPRMC, 120325.00,A,4717.15266,N,00833. 96293 ,E,1.734,41.10,010408, , , A%5D
12:03:25 $GPVTE,41.10,T,,M,1.734,N,3. 213, K, A*0B
12:03:25 $GPGGA, 120325.00,4717.15266,N,D00833. 96293 ,E,1,06,1.19,419.2,M,45.0,M, , *54

W
® | X ||
Figure 15: Text Console displaying UBX-INF and NMEA messages
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$EPRMC, 120310,
12:03:11  $GPRMC, 120311.00,A,4717. 14048, N, 00833 . 94323 ,E
17:03:12 $GPRMC,120312.00,4,4717. 14066, N,00833. 94352,
12:03:13  $GPRMC,120313.00,A,4717. 14114, N,00833.94379,E
12:03:14  $GPRMC,120314.00,4,4717. 14192, N,00833 . 94454, E
12:03:15 $GPRMC, 120315.00,4,4717. 14280, N,00833 . 94602, E
17:03:16 $GPRMC,120316.00,4,4717. 14373, N,00833. 94761, E
12:03:17  $GPRMC,120317.00,4,4717. 14472, N,00833 . 94898, E
12:03:18 $GPRMC, 120318.00,4,4717. 14578, N, 00833 . 95095, E
17:03:19  $GPRMC,120319.00,4,4717. 14687, N,00833.95303,E,1. 334, 318.40,010408, , , A*6D
12:03:20 $GPRMC,120320.00,4,4717.14796,N,00833. 95480,E,1.509,323.57,010408, , , A*6C

00,8, 4717. ,0
L0
.0
,0
L0
W0
.0
0
.1
!
L]

12:03:21 $GPRMC,120321.00,4,4717.14900, N,00833.95629,E,1.492, 328.00,010408, , , A¥67
1
L
.1
,2
.1
.1
.1
.1
L0
.0
,0
L0

14011, N,00833. 94302, E,0. 608, 297.
.342,293.65,010408, , , A%66
.2FZ,287.43,010408, , , A*6C
.195%,283,39,010408, , , A¥E3
.175, 285, 86,010408, , , A*6E
.555,293, 28,010408, , , A*6E
.7E9,300.36,010408, , ,A%66
.787,306.25,010408, , , A*62

.119,312.45,010408, , ,A%61

72,010408, ,,4%61

12:03:22 $GPRMC,120322.00,A,4717.14999, N,00833. 95818, E,1. 676, 332, 59,010408, , , A®67
12:03:23 $GPRMC,120323.00,A,4717.15089, N,00833.95982,E,1. 724, 336. B4,010408, , , A*&F
12:03:24 $GPRMC,120324.00,4,4717.15183,N,00833.96159,E,2.109,41.31,010408, , ,4%50
12:03:25 $GPRMC,120325.00,R,4717.15266,N,00833. 96293 ,E,1.734,41.10,010408, , , A%5D
12:03:26 $GPRMC,120326.00,A,4717.15358, N,00833. 96438, E,1. 794,40, 80,010408, , ,A%57
12:03:27 $GPRMC,120327.00,A,4717.15397,N,00833. 96504 ,E,1.537,40.43,010408, , , &A%5F
12:03:28 $GPRMC,120328.00,4,4717.15400, N,00833. 96539,E,1.251,40.39,010408, , , 4%50
12:03:29 $GPRMC,1203259.00,R,4717.15373, N,00833. 96519, E,0. 865,40.10,010408, , , ASA
17:03:30 $GPRMC,120330.00,A,4717.15308, N,00833. 96439,E,0. 347, 39.63,010408, , , &%5C
12:03:31 $GPRMC,120331.00,4,4717.15230, N,00833.96332,E,0.088, 36.29,010408, , ,A*5A
12:03:32 $GPRMC,120332.00,8,4717.15097,N,00833.96202,E,0.382,47.03,010408, , , A¥53

& | x (R
Figure 16: Text Console displaying only RMC messages

Element Name Description

& | & Lock Prevents the Text Console from being updated with new data
when locked.

X Clear All Erases all data in the Text Console

Filter On/Off Filter unwanted data from the data stream. This allows searching
for certain expression, e.g. all RMC messages (Figure 16).

Table 3: Description of the buttons of the different Consoles

4.5.1.1 Regular Expression Evaluation

Normally, when you search for a sub-string in a string, the match should be exact. So if we search for a sub-
string "abc" then the string being searched should contain these exact letters in the same sequence for a match
to be found. We can extend this kind of search to a case insensitive search where the sub-string "abc" will find
strings like "Abc", "ABC" etc. That is, the case is ignored but the sequence of the letters should be exactly the
same. Sometimes, a case insensitive search is also not enough. For example, if we want to search for numeric
digit, then we basically end up searching for each digit independently. This is where regular expressions come in
to our help. Regular expressions are text patterns that are used for string matching. Regular expressions are
strings that contain a mix of plain text and special characters to indicate what kind of matching to do. Here's a
very brief tutorial on using regular expressions.

Suppose, we are looking for a numeric digit then the regular expression we would search for is "[0-9]". The
brackets indicate that the character being compared should match any one of the characters enclosed within the
bracket. The dash (-) between 0 and 9 indicates that it is a range from 0 to 9. Therefore, this regular expression
will match any character between 0 and 9, that is, any digit. If we want to search for a special character literally
we must use a backslash before the special character. For example, the single character regular expression "\*"
matches a single asterisk. In the table below the special characters are briefly described. A regular expression
search is case sensitive.

GPS-SW-08007-A Released Menu Structure
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Character Description

A Beginning of the string. The expression "AA" will match an ‘A’ only at the beginning of the
string.
The caret (*) immediately following the left-bracket ([) has a different meaning. It is used to

" exclude the remaining characters within brackets from matching the target string. The
expression "[A0-9]" indicates that the target character should not be a digit.

$ The dollar sign ($) will match the end of the string. The expression "abc$" will match the sub-
string "abc" only if it is at the end of the string.

| The alternation or logic OR character () allows either expression on its side to match the target
string. The expression "alb" will match ‘a” as well as ‘b’

. The dot (.) will match any character.

* The asterisk (*) indicates that the character to the left of the asterisk in the expression should
match O or more times.

+ The plus (+) is similar to asterisk but there should be at least one match of the character to the
left of the + sign in the expression.

? The question mark (?) matches the character to its left 0 or 1 times.

O The parenthesis affects the order of pattern evaluation.

[] Brackets ([ and ]) enclosing a set of characters indicates that any of the enclosed characters may
match the target character.

4.5.1.2 Example

Let’s assume that the following lines would appear in the NMEA console without filtering.

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M, ,,,0000*09
14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A

14:00:03 $GPGSV,2,1,07,06,58,062,44,17,52,161,44,25,45,239,44,22,35,301,44*7F
14:00:03 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:03 $GPVTG,80.59,T,,M,0.03,N,0.1,K*56

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M, ,,,0000*0F

14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A

14:00:04 $GPGSV,2,1,07,06,58,062,45,17,52,161,44,25,45,239,44,22,35,301,44*7E
14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201, ,*0D
14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B

In the following examples the characters marked red match the regular expression.

Example 1:

Searching for the RMC with a valid position and all GGA Messages
“GP(GGA|RMC, .*,A,)"

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M, ,,,0000*09
14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F
14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201, ,*0D

Example 2:

Searching for all GSV with the message index of ‘2" or '3’
“GSV, .*,[2-3],"

14:00:03 $GPGSV,2,2,07
14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

,30,31,123,44,10,17,059,39,01,05,316, *4E

GPS-SW-08007-A
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Example 3: Searching for all messages starting with $GP, which have a ‘G’ in the message identifier but not

at the first position
"MSBGP . +G_*, "

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M, ,,,0000*09
14:00:03 $GPVTG,80.59,T, ,M,0.03,N,0.1,K*56
14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M, ,,,0000*0F
14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B

Example 4: Searching for all message having a checksum of which the higher nibble is 3
“\*3.8$"

14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A

4.5.2 Packet Console

The Packet Console lists all incoming messages and provides information about message length and type.

UBX MNAV-SWINFO, Size 208, 'Satellite Status and Information’'
UBX NAV-SOL, Size 60, 'Nawigation Solution’

UBX NAV-POSECEF, Size 28, 'Position in ECEF Frame'
UBX NAV-POSLLH, Size 'Geodetic Position'

UBX NAV-DOP, Size 26, 'Dilution of Precision’

UBX NAV-STATUS, Size 'Mavigation Status'

UBX NAV-WELECEF, Size ‘velocity in ECEF frame'
UBX NAV-WELMED, Size "Welocity in WaS 84 '

UBX NAV-TIMEGPS, Size 24, 'GPS System Time'

UBX MAV-TIMEUTC, Size 2B, 'Uniwersal Time Coordinated’
UBX NAV-CLOCK, Size 28, 'Clock Status'

UBX NAV-SWINFD, Size 208, 'Satellite Status and Information'
UBX NAV-50L, Size 60, ‘'Mawigation Solution'

UBX NAV-POSECEF, Size 28, 'Position in ECEF Frame'
UBX MAV-POSLLH, Size 36, 'Geodetic Position'

UBX NAV-DOP, Size 26, 'Dilution of Precision'

UBX NAV-STATUS, Size 24, 'Navigation Status'

UBX NAV-WELECEF, Size 28, 'Velocity in ECEF frame'
UBX NAV-WELNED, Size 44, ‘'Velocity in WG5S 84

UBX NAV-TIMEGPS, Size 24, 'GPS System Time'

UBX NAV-TIMEUTC, Size 28, 'Uniwversal Time Coordinated’
UBX NAV-CLOCK, Size 28, 'Clock Status'

UBX NAV-SWINFD, Size 208, 'Satellite Status and Information’'
UBX MNAV-SOL, Size 60, 'Mawigation Solution'

UBX NAV-POSECEF, Size 28, 'Position in ECEF Frame'
UBX NAV-POSLLH, 5Size 36, 'Geodetic Position’

UBX NAV-DOP, Size 26, 'Dilution of Precision’

UBX NAV-STATUS, Size 24, 'Mavigation Status'

UBX MAV-WELECEF, Size 28, 'Velocity in ECEF frame'
UBX NAV-WELMED, Size 44, ‘'velocity in WSS 84

UBX NAV-TIMEGPS, Size 24, 'GPS System Time'

UBX NAV-TIMEUTC, Size 28, 'Uniwversal Time Coordinated’
UBX MNAV-CLOCK, Size 28, 'Clock Status'

UBX NAV-SWIMFO, Size 208, 'Satellite Status and Information'
UBX NAV-SOL, Size 60, 'Nawigation Solution’

UBX NAV-POSECEF, Size 28, 'Position in ECEF Frame'
UBX NAV-POSLLH, Size 36, ‘'Geodetic Position'

UBX MAV-DOP, Size 26, 'Dilution of Precision’

UBX NAV-STATUS, Size 24, 'Nawvigation Status'

UBX NAV-WELECEF, Size 28, 'Velocity in ECEF frame'
UBX NAV-WELMEDY, Size 44, ‘'welocity in Was 84

UBX NAV-TIMEGPS, Size 24, 'GPS System Time'

UBX MNAV-TIMEUTC, Size 2B, 'Uniwversal Time Coordinated’
UBX NAV-CLOCK, Size 28, 'Clock Status’

UBX NAV-SWIMFD, Size 208, 'Satellite Status and Information’
UBX NAV-5OL, Size 60, 'Mawigation Solution'

UBX MAV-POSECEF, Size 28, 'Position in ECEF Frame'
UBX NAV-POSLLH, Size 36, 'Geodetic Position’

UBX NAV-DOP, Size 26, 'Dilution of Precision'

UBX NAV-STATUS, Size 24, 'Navigation Status'

UBX NAV-WELECEF, Size 28, 'Velocity in ECEF frame'

3| X @

Figure 17: Packet Console

Refer to Section 4.5.1 for an explanation of the icons and text fields.
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4.5.3 Binary Console

The Binary Console lists all incoming messages in binary and ASCII format.

00 00 00 0QO0Ipyy0ODODOOODO
00 49 7B 00000000000000I{
LbO000ADGD
3 a7 wbO000BOOO00O0G
1253121
12:31:21
12:313:21 1B wbO000ADOO00RO
12:31:21 wbOOOOODOE
12:31:21 ubOOOOADYD
12:31:21 K“bDOO0ADDOOOY
12:31:21 wbOOOOODOE
12:31:21 LbO000ADRD
12:31:21 wbO000ADOOOOO%
12:31:21 ubO0000000E
1231221 wbOOOOO!
12138221 ub0000ADDO000/
12:31:21 wbOOOOODOE
12138221 ubOoooo £
12:31:21 wbOOOOODOS
12:31:21 ubo$oo®,
12:31:21 00 00 03 03 10 02 50 €3 pbOO{00DOOODDORA
00 00 FA OO0 FA OO0 @4 00 00000<0000G0G0dO
00 0D OO0 0D 0D OO0 S6 3A |, 0000000000000V :
12:31:21 28 51 wb000000 (G
12:31:21 ubooaooo]
12:31:21 31 56 wbOoOoooo$1v
12:31:21 21 ubODOODO!
12:31:21 00 02 46 54 WbOOO0OXOOFT
12:31:21 25 4E “bOOOOODEN
l2Taiad2 FC OC 84 16 04 OO0 C1 05 pbO040>0u0,00040
D% 03 74 4F CC 1B 6F 05 O¥ALED"$00L0I000
FF FF FF FF FF FF 17 00 DOO0O0Ryy¥5¥¥500
41 40 73 71 00 DOODDA@sq
12:31:22 FC OC CO 74 BC 19 22 24 pb0O0DO0>000RCED"$
00 00 43 54 00t0I0c000IT
12:31:22 FC OC EA O3 1B 05 3A 46 ub0ODO0=0u08000:F
06 00 5A 14 0D OO0 85 2F /0OPOOY.00Z000./
oo
12531322 FC OC 48 01 20 O1 9E 00 wbOOO0-0GOHD 020
bE A9 0000d0o0ne
12531322 FC OC 03 DD Q0 00 C4 EC  ubOOOO-0GO0YOOAT
003r00,
131322 FC OC 00 OO 00 OO0 FE FF  pbODOO>0u00000pyF
00 00 4E 7B FEyFO000NT
12:31:22 FC OC FF FF FF FF FE FF pbDD30-000F55by
00 00 02 00 0D 00 40 9F ¥¥000000DO0DDDEY
OF 02 F1 9D §00000, E0OAD
12:31:22 FC OC &84 16 04 00 C1 05 wbO 00-000,000A0
0oooooIo
12138282 FC OC 14 DD QD OO0 05 82 pbO!00-00000000°
24 03 1B DO 4y@00000%008
3
B x|@I
Figure 18: Binary Console
Refer to section 4.5.1 for an explanation of the icons and text fields.
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4.5.4 Message View

The Message View is utilized to communicate with the GPS receiver. Receiver output messages (e.g. navigation
output, status and debug information) are displayed; input messages (e.g. configuration messages) can be sent.
There are different sections for NMEA and UBX protocol.

3 Messages - NMEA - GPGGA (Global Positioning System Fix Data)

B NMEA - GP5A (Gobal Poiioring System Fix Dta)
59665 (G5 saelite Fauk Detection)
T ] Parameler | Value | Unit| Deserption
GPGLL (Geographic Postion - LattudelLongiuder | [urc 1232000 Hhmssss Uriveral ine cordnated
7GRS (G155 Range Residust Lt 708774 ddnmannnn Lattude
69G5A (@155 DOP and Active Sstslites) Nothing ndicstor N NoNloth 5
GRGT (GNSS PseLrange Ercr Statitis) Lon 00833 34608 dddmmmmnm  Longlude
o S 5 iyl 15/ 24D6PS, 6Dend ek
alus e, 120,30, 2-D1GFS, G=Dead Reckorin
o R W v 11 b of Vs e ot Navigaton ’
0P 085 Horizontal Diton o Pecision
TG ALMSL) s01.7 - Abiude (above reans sealevel)
GP2DA (Time tDate) Uri M Mebelers
PuEx Geoid Sep. a3 ' Geoid Separaion = ARHAE) - ARMSL)
o ke Uri M
s hge of DGPS Can .
e DGPS Ret Station
UkNOwN
auston

0000 24 47 S0 47 47 41 2C 31 32 33 32 34 30 2E 30 30 2C 34 §GPGGA,123240.00,4
001z 37 31 37 2E 30 39 37 37 34 2C 4E 2C 30 30 38 33 33 2E 717.09774,N,00833.
0024 39 34 36 30 38 2C 45 2C 31 2C 31 31 2C 30 2E 38 35 2C 04608,E,1,11,0.85,
0036 35 30 31 2E 37 2C 4D 2C 34 37 2E 33 2C 4D 2C 2C 24 35 SOL.7,IL47.3,H,, 75
ooss 37 0D o4 7m0

1 O I
_ & | | B oo (X &

Figure 19: Message View

Element Name Description

3 | [-E] Lock Prevents the Message View from being updated with new data
when locked.

o4 Clear All Erases the entire Message View.

= Send Sends the current message to the GPS receiver.

e Poll Polls the selected message once.

g Auto poll Automatically polls a newly selected message once

BE] Message Hotkey Assigns a hotkey to the selected message

Table 4: Description of the buttons in the Message View

GPS-SW-08007-A Released Menu Structure
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4.5.4.1 Receiver Output Messages

P Messages - UBX - NAV. (Navigation) - POSECEF (Position ECEF)
A
Bk

UBK - NAY (Navigston] - POSECEF [Posion ECEF) g

ACK (Ackrovledos)

AID (GPS Aiding) Time of ek 220272.000  [s]
CFG (Canfigh
INF (Information) ECEF-X 428647183 [m]

- MON ECEF-Y 64554686 [m]
NAY (Havig:
CLOCK (Clock Status) ECEF-Z 466372881 ]
DGPS (DGPS Data) Accuracy Estimate
 DOP (Diution of Frecsion)
Pasiion 3D 843 Iml

EKFSTATUS (Status)
[POSECEF (Postion E<ER)]

A\ Posiir tGeodketic Pasitor)
POSUTH (Position UTM Grid)
SBAS (3845 Status)

50L (Navigation Solutor)

STATUS (Navigation Ststus)
SUINFO (5 Information)
TIMEGPS (GPS Time)

+ TIMELITC (UTC Time)
VELECEF (velodity ECEF)
VELNED (Yelocty Wesas)

B RAM (Receiver Manager)

TIM (Treing)

27 {Unkeown)

27 {Custorn)

UNKNOU

cusTom

GOv0 55 ¥ 01 01 1% 60 0% 11 71 00 10 4% 5C 13 €5 70 18 63 phon 01 miee——
0012 2F 49 ©C 1B 44 03 00 00 CZ 8E /1i0J0004%

S | X | B ¥eal [5E | &

Figure 20: Message Display of an output message

& Double-clicking on an output message enables or disables the periodic message update if the
communication protocol is active. This feature is currently only supported for the UBX protocol.

4.5.4.2 Receiver Input Messages

Input messages can be edited and sent to the GPS receiver from the Message View. It is also possible to poll the
current receiver settings.

[ o B o P P ! |

B NMEA, ~
= UBX
B ACK (Acknowledge)

B- AID (G5 Airding) Target |3 -1USE vl

B CFa [Config)

- AT (Antenna 5 Protocal in |D+1 - LB +MNMEA, -I
eraenfioust - Protoccl ot [0+1 - UBX+HMER =]

- DAT (Diakum)
- EKF (EKF Setting -
e FM (Fie Mo Mg

- INF (InfMessage

- LIC {License)

- M3G (Messagesi—
- MAY (Mavigation ol |

- AYE (Navigatio
MAYS (Mavigatio o000 BS 62 06 00 14 00 03 00 wb00O0000
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UBX - CFG [Config] - PRT [Ports] 4022

Figure 21: Message Display of an input message

& u-center performs some range checks on input messages. If an input value exceeds the permitted range,
u-center will highlight the field in red but it is still possible to send the value to the receiver. However, the
receiver is likely to reject such a message.
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4.5.5 Statistic View

All available GPS values (transmitted from the GPS receiver or calculated by u-center) are displayed. The
following statistics are displayed:

e Current Value
e Minimum Value
o Maximum Value

e Average Value
Standard Deviation

3! statistic View

Tikle | Counk Age | Current Mairnurn Awverage | Dierviation | Unit | Descripkion

uTC 3778 0 13:34:09.001.. 13:34:09.001... time date  Time UTC

GPS time 3778 0 1473221663, d 14731221663, wnaikow  Time GPS

TTAG 3779 1} 221663001 217554.995 221663.001 s TTAG (from ITOW)

TaCC s 1 [ 0.012000 0.069000 0.019155 0.006005 us  Time Accuracy

TimeSkarkup 377G a 4451.615 674,629 4451.615 2563115 1090.617 5 Time since Startup

TTFF 1 s rrr 1 60,612 60,612 60,612 0,000 s Time ko first Fix

Lak 3775 a 47.285180 47.284915 47 286672 47.255185 0.000177 @ Position LTP Latitude

Lon 3778 1} 8.565771 8.565298 8.566504 8.565715 0.000095 ¢ Position LTP Longitude

Ak (HAE) 3775 1} 563,78 355,44 602,46 563,39 25.75 m  Position LTP Alitude (ab...

Alt {M5L) 377G a 515,79 340,44 554.46 515.40 25.75 m  Position LTP Altitude {ab...

kS 377G a 4256476,.56 4286236,53 4256500.32 4256476.24 28.25 m  Position ECEF X

¥ 3775 a 645649.52 645595,11 6456580.52 645645, 16 7.56 m  Position ECEF ¥

Z 377G a 466374363 4663699, 55 466575741 4663743.99 15.69 m  Position ECEF 2

P&CC 30 3778 1} 7.140 6.850 37.320 9.774 2.544 m  Position Accuracy 30

PACCH 3775 1} 4.521 4,247 30,922 6,090 1.704 m  Horizontal Position Accu...

P&CCY 377G o 5.530 5.326 21,962 7.596 2,077 m  Vertical Position Accuracy

WK 377G a 0.o0 -0.22 1.09 0,01 0.06 mys  Welocity ECEF ¥

W 377G a 0.o0 -1.25 2.62 -0.00 0.07 mys  Welocity ECEF ¥

WE 3775 a -0.01 -1.29 0.65 0.0z 0.13 mfs  WVelocity ECEF Z

WM 3778 1} 0.00 -1.90 0.32 0.01 0.10 mfs  Yelocity LTP Morth

VE 3775 1} 0.00 -1.39 244 -0.00 0.05 mfs  Welocity LTP East vy
——

Figure 22: Statistic View

& Choosing Database Empty in the File Menu or pressing the Button & deletes the Statistic View.
& The content of the Statistic View can easily be exported to other programs using Copy/Paste.

4.5.6 Table View

All values from the database can be displayed in a tabular form (Figure 23). This is very useful when analysing
logfile in detail.

Table - [Index / UTC / Lat / Lon / Alt (HAE) / PDOP / Used SVs] M=1E3
uTcC Lak Lon Alk (HAE) FDOP Used Sis 2
14:01:07... 47.285012 §.565717 554.45 3.5 24,152,
14:01:08... 47.285010 §.565717 554.40 3.5 Z2,4,15,2...
14:01:09... 47.285009 8.565717 E54.35 3.5 2,4,13,2...
14:01:10.., 47285003 8.505716 554,30 35 2,4,13,2..
14:01:11... 47.285007 §.565716 554.23 3.5 24,152,
14:01:12... 47285007 §.565715 554.15 3.5 Z2,4,15,2...
14:01:13... 47.285007 8.565713 C54.17 3.5 2,4,13,2...
14:01:14.., 47, 285005 8.505712 o417 35 2,4,13,2..
14:01:15.., 47285006 §.565711 554.16 3.5 24,152
14:01:16... 47. 285006 §.565710 554.13 3.5 Z2,4,15,2...
14:01:17... 47. 285006 §.565710 554.13 3.5 24,132,
14:01:18.., 47, 285005 8.565709 o412 35 24,132, —
< LI
= = |UsedSvs -

Figure 23: Table View
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@ biox

To add a new column, first select the desired value (Figure 24) and click the + Button. To remove a displayed
value, click the — Button. To see the Table header click the =] Button.

]i=JE
Used Sis | A

2,4,13,2...
2,4,13,2...

[ Table - [Index / UTC / Lat / Lon / Alt (HAE) £ PDOP / Used SVs]

Alt (HAE)
548,02
548,70

Lak Lon PLDOP
47, 255006 5.565746

47285009 8.565744

47.285012
47, 285015
47, 285017

5.565742
§.565739
§.565737

549,23
549.59

550,41

2,4,13,2...
2,4,13,2...
2,4,13,2...

&

&
&

47285018
47285018
47, 285020
47, 265021
47, 285022
47285021
47285020

3.565736
8.565734
5.565733
§.505752
§.505732
3.5657352
8.565732

550,77
551.11
551.52
551,83
552,09
552.14
552,08

2,4,13,2...
2,4,13,2...
2,4,13,2...
2,4,13,2...
2,4,13,2...
2,4,13,2...
2,4,13,2...

i)
8 + SW2Mode v

SW2 Mode
SW2 Used
SW2EI
V2 Az -
G2 CND

5V2Ch

52 Doppler

SW2 Residual

52 Range

SW2 Carrier

SW3Mode

543 Used

SVIEI

543 Az

>

SW3Ch

543 Doppler

5%3 Residual

SW3 Range

53 Carrier

SV Mode

544 Uszed v

Figure 24: Selecting a new value

The number of displayed epochs is set to 1800 by default (see also section 3.2.5 Database Limitation).

Choosing Database Empty in the File Menu or pressing the Button & deletes the Table View.

The content of the Statistic View can easily be exported to other programs using Copy/Paste.

With the function Recent Table View one of the last 8 used tables can be selected (Figure 25) and displayed.
F11 |

Table View
it Tab

1 lndex / TDOF / Tracked Ss
2Index / TDOP / SW2 Ch
3Index /WDOP

4 |ndex / VD

&Index / SWV1E El

B Index / Colz

7 lndex /UTC

8 Index / 5432 C/NO

Figure 25: Recently used tables

4.5.7 Chart View

Chart View allows the user to conveniently view GPS-Data records in graphical form. The data can be scaled in
many different ways and formats. It's even possible to print the entire chart.

GPS-SW-08007-A Released Menu Structure

Page 26 of 57



@b I ox u-center - User’s Guide

The examples below illustrate 3 different typical applications

8 Chart - [Alt (HAE) / Index]

o B E - Tyl armeE BT | Ad

< - >
B RKE-I Y f e % [alHAE] ~| | A

Figure 27: Index as a function of Altitude (X = Altitude, Y = Index)

B Chart - [Lat / Lon]

£

>
e d &R - I F v | |+ R Lo - || A

Figure 28: Latitude as a function of Longitude (X =Longitude, Y = Latitude)
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Element Name Description

s Cursor The cursor position is shown in the lower left edge of the u-
center windows. Click the right button mouse and hold the
button down to measure differences.

Move The chart is moved inside the Chart View Window. Click and

Drag/Drop the Chart.

& Zoom In Drawing a rectangle enlarges the chart to the new view. To zoom
in the Chart 2x click on the chart

IE Zoom Out Drawing a rectangle decreases the chart to the new view. To
zoom out the Chart 2x click on the chart

. Drawing Mode The size and form of the displayed values can be changed in the

menu points; the connection line between the values can be
selected in the menu Connect. For viewing the statically values
(average, minimum, maximum, standard deviation) directly in the
chart select the Statistics Menu

FitY

Fit the Y Range

Follow Y

Follow the most current Y-Value (the most current Y-value is
always in the middle of the chart)

Index or Y Value

Switch between the Index and the Y Value

|Lat j Y Value Select the Y Value to be displayed
IE Fit X Fit the X Range
Follow X Follow the most current X-Value (the most current X-Value is

always in the middle of the chart)

Index or X Value

Switch between the Index and the X Value

I Lon j

X Value

Select the X Value to be displayed

L I‘IE.III vI

Moving Average

Adds a moving average. The average is calculated over the
number of most recent values, specified with the parameter.

Table 5: Description of the buttons and displays in Chart View

& The number of displayed epochs is set to 1800 by default (see also section 3.2.5).

GPS-SW-08007-A
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4.5.8 Histogram View

Histogram Views allow the user to view GPS-Data and probability distributions (Figure 29) and print the entire
histogram if desired. The number of bins (storage containers) can be set by the user.

Histogram - [Alt (HAE) with 64 bins] X

o RO - Lo | T e anmag) ~| [e4 ~
Figure 29: Altitude Histogram View

E® Histogram - [Alt (HAE) with 64 bins]

= N N R e e Y e A T |

Figure 30: Probability Chart

& The number of displayed epochs is set to 1800 by default (see also section 3.2.5).
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Element Name Description

s Cursor The cursor position is shown in the lower left edge of the u-
center windows. Click the right button mouse and hold the
button down to measure differences.

Move The Histogram is moved inside the Histogram View Window.

Click and Drag/Drop the Histogram.

& Zoom In Drawing a rectangle enlarges the Histogram to the new view. To
zoom in the Histogram 2x click on the Histogram

IE Zoom Out Drawing a rectangle decreases the Histogram to the new view.
To zoom out the Histogram 2x click on the Histogram

. Drawing Mode The size and form of the displayed values can be changed in the

menu Points. The connection line between the values can be
selected in the menu Connect. For viewing the statically values
(average, minimum, maximum, standard deviation) directly in the
Histogram select the Statistics Menu

Probability

Display the probability Histogram (Figure 30)

Fit Probability

Fit the Probability Range

IE Fit X Fit the X Range
I’*‘“ HAE] j Y Value Select the Y Value to be displayed
4 - Bins The number of Bins

Table 6: Description of the buttons and displays in Histogram View

GPS-SW-08007-A
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4.5.9 Camera View

The Camera View function enables photographs, taken during recording of log files, to be linked to the GPS
data stored in the corresponding log files. This allows a video depiction of the test, with a picture assigned to a
specific point of GPS data.

W u-center
Fia Eft Vew Playsr Recever Took Window Help
Od&EF- o & P a8

Am o(n[pin|k—F—— |4 |kl E||&

ol Y%

Goko Position Z1'341'613 | 4963926 - COML SPE00N u-blox § u EVK5H_4,00_goodants LEX 00:11:01 [13:27:00 | &

Figure 31: Camera View

& Using Camera View can result in very large logfiles and can slow down u-center when playing such files.
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4.5.10 Deviation Map

The Deviation Map displays positions in longitude and latitude relative to a defined reference position.

L2 Deviation Map

159, EITI

o5 | [ <[

Figure 32: Deviation Map

Element Name Description
Properties The Reference Position can be defined as:

The average of all previously measured positions
The current position
A fixed, predefined value

The radius of the outer circle can be adjusted with the Max.
Deviation parameter.

E., Fit Automatically adjusts the Reference Position and the Max.
Deviation to fit all positions into the Deviation Map.
Track
T+ Statistics

Table 7: Description of the buttons and displays in Deviation Map

& The number of displayed epochs is set to 1800 by default (Section 3.2.5).
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4.5.11 Map View

u-center can display positions on pre-calibrated maps (Figure 33). This allows a basic analysis of road tests.

B Map - [office-free. jpge]

Wu-blox AG, Zurcherstrasse 68, CH-8800 Thatwil, Switzerland  httplfananw u-blox.com =
<

bR K[ ] e e A BT

b

Figure 33: Displaying a position

4.5.11.1 Using Map View
You can access the view specific commands in two different ways:

e Using the command in the Tool Bar below the Map View.
e Holding the cursor inside the Map View and pressing the right mouse button will. This will open a context

menu:
Zoom Factor Adjust Colors
kR[S @ A S
Curszor
* Move
Zoom Jn
Zoom Quk
Fit Map
Markers
Follaw
* Mane
Dot Cornect  ® Qpen Map.. |
Bold Dop Statiztics Becent Maps 3 |
Save Map View...
Cross
Bold Crozs LCopy
GPS-SW-08007-A Released Menu Structure
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Element Name Description

s Cursor The position of the cursor is shown on the lower left edge of the
u-center screen (Longitude, Latitude and Pixel-Position). By
holding the left mouse button and moving the cursor over the
map you can measure distance from one position to another

& Move The map inside the Map View Window can be moved

& Zoom In The map is enlarged by selecting a rectangle

Zoom Out The size of the Map is decreased

Zoom Factor

Different specific zoom level can be selected

Drawing Mode

The size and form of the displayed position can be changed; the
connection line between the points can be selected in the menu
Connect. To see statically values (average, minimum, maximum,
standard deviation) directly in the map, select the Menu Statistic.

W Fit Map The map size is adjusted to fit the Map Window

s Follow Center the map on the current GPS position

k. Markers Add or remove the defined markers (see also 4.5.71.3 Map
Calibration)

B . Open Map Load a new or one of 8 recently used maps.

= Save Map View The current display can be stored in different formats

—
-—
—

Adjust Colors

Brightness, contrast and color saturation of map can be adjusted
by moving the glides

Table 8: Description of the buttons and displays in Map View

positions and routes.

GPS-SW-08007-A

Map Views can be copied to the clipboard using the ‘Print Screen’ function.

Choosing Database Empty in the File Menu or pressing the Button = deletes all recently displayed

Released Menu Structure
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4.5.11.2 Application example: Reviewing a road test
e Open a u-center logfile (refer to Section 4.3).

« In the Player Menu or player Tool Bar | = ® (& ¥ -» i 4 | select the menu Play or
click the button '~ Deactivate in the Player Menu Pause or click the button

e Now, the stored positions are displayed (Figure 34).

[ Map - [officemapoverlay.bmp]

<
b ®A i L@ bk b F-BE W

Figure 34: Logfile from a road test

4.5.11.3 Map Calibration

To create your own map you will need a digitized map or pictures with orthogonal projection in one of the
following pixel graphics formats.

e png Portable Network Graphics,
e bmp Windows Bitmap

o dib Device Independent Bitmap
o gif Graphics Interchange Format
* jpg/jpeg Jpeg File Interchange Format
e pcx PC paintbrush

o tif Tag Image File Format

If your map is not in one of the above formats, you can simply convert it in one of the supported formats by a
third party program. u-blox provides two sample maps. Office.png is a small map of the surroundings of the u-
blox headquarters. World.png is a map of the whole world but with limited resolution.

To use a map in u-center, three calibration points are needed. For these points you have to know the pixel
coordinates and the according WGS84 coordinates in the latitude/longitude format in degrees (longitude: -180.0
to 180.0, latitude: -90.0 to 90.0). These points are stored in the map calibration file. The calibration file must be
stored at the same location as the bitmap itself. It has the same name but a different extension (*.mcf). The
Format of the calibration file is very simple and can be edited in a simple editor like notepad.

GPS-SW-08007-A Released Menu Structure
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Examples:

As an example we will have a closer look at the provided map ‘world.png"' and its calibration file 'world.mcf".

Y/X

v

v
Digital Map File: world.png

The Map has 1765 Pixels (0 to 1764) in the horizontal and 1046 Pixels (0 to 1045) in the vertical direction. The
origin is the upper left corner. To calibrate this map we will use the following three calibration points (#1 to #3).

Pixel WGS84 Coordinate
Reference Point # | X Y Longitude | Latitude
Upper Left Corner 110 0 -180.0 90.0
Lower Right Corner 2 [ 1764 | 1045 | 180.0 -90.0
Upper Right Corner 311764 |0 180.0 90.0

To determine the exact pixel position you can use Microsoft Paint (mspaint.exe) or any other pixel-editing
program.

The calibration file is a plain ASCII text file. The file may contain comments. The file consists of two sections,
which start with keywords encapsulated in braces.

The REFERENCE section, which is mandatory, contains the three points used to calibrate a map. Each reference
point is on a single line and has the following syntax:

“# = <x>, <y>, <lon>, <lat>”

where # is the index of the reference point <x> is the horizontal and <y> is the vertical image coordinate and
<lat> is the Latitude and <lon> is the Longitude in degrees and WGS84.

The MARKER section, which is optional, defines additional points on the map. Each point is on a single line with
the syntax:

“#o= 0, <x>, <y>[, <text>]” or “# = c, <lat>, <lon>[, <text>]”

where # is the index of the marker point <x> is the horizontal and <y> is the vertical image coordinate or <lat>
is the Latitude and <lon> is the Longitude in degrees and WGS84. <text> is a optional string in quotes labeling
the marker point. The points must have a unique index from 1 to <num>. The maximum marker point index
<num> is written to the same section on a separate line with the syntax “Count = <num>".

GPS-SW-08007-A Released Menu Structure
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s I NFO

; File: world.mcf
; Source: (sample data set)

REFERENCE

3 Points must be defined to calibrate a Map

Parameters:
# = index of the point (1 to 3)

; X,y = image coordinates
; lat,lon = world coordinates
; Syntax:
= # = <x>, <y>, <lon>, <lat>
[REFERENCE]
1= 0, 0, -180.0, 90.0
2 = 1764, 1045, 180.0, -90.0
3 = 1764, o, 180.0, 90.0

MARKER

; You can add points (image or world coord) to the map
; Parameters:

; num = number of markers that follow

; # = index of the point (1 to num)

; type = c for world or i image coordinates

; X,y = image coordinates

; lat,lon = world coordinates

; text = quoted text decription to the marker (optional)
; Syntax:

; Count = <num>
= # = <type>, <x|lon>, <y|lat>[, <text>]

[MARKER]
Count = 1
1 = c, 8.56525, 47.28519444, "u-blox ag"

Map Calibration File: world.mcf

GPS-SW-08007-A Released Menu Structure
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4.5.11.4 Map Calibration Tool

u-center includes a built-in calibration tool for providing coordinates to maps and photographs in supported data
formats to create u-center maps. To use the tool open the Map View window as seen in Figure 35 and then as
seen in Figure 36 open the file of the map to be calibrated (in our example GoogleScreenShot.bmp).

File Edit Flayer Receiver Tools Window Help
ODE Packet Console F& A m
2 Binary Console F7 2

fap= - Text Conscle F& > - M

Messages View Fa
Configuration View Chrl+F2

Statistic View F10
Table Yiew Fi1
Recent Table Views

Recent Map Views
Chart View

Recent Chart Yiews
Histogram View
Recent Histagrarn View
Camera View

Deviation Map
Sky View

Docking Windows
Toolbars

Figure 35: Opening Map View Window

Look in: IE} u-center j = £k B
= EWUrId.png
'.J @u-blox demo.png
Recent S co0 .

|C5) Documentation

My Documents

My Computer

by Metwork, File name: IGoogIeScreenShot.bmp j Open I
Flaces
Files of type: IMap Files [".png;".ipg;".ipeg;".gif;".tif;".pcx;".bm|L| Cancel |

&

Figure 36: Opening the file of the map to be calibrated

If the file to be opened has not been calibrated, the following message will appear:

There iz ho calibration file for this map. Please press Yes to start the calibration process:
\V first click on a known position inzide the map, then enter the coordinates into the dialog box.
Attention; pozition click plus coordinates entering has to be repeated three times!
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Select three points on the map and enter the calibration coordinates in the specified format as seen in Figure 37,
Figure 38 and Figure 39.

. Map - [GoogleSereanShot, binp] ) 3

>

<
L S S TR = o A~ - = R

Figure 37: Calibrating a Map Using Calibration Tool (position 1)

- B )S_I
it | WS84 Lak/Lon in Degree. Minutes and Seconds
e B Lo 345
Lat* Ic? Lat' 17
< i i &
EeRA[or o F- b A F-BE T
Figure 38: Calibrating a Map Using Calibration Tool (position 2)
GPS-SW-08007-A Released Menu Structure
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| [WG5B4 Lal/Lon in Degiee, Minutes and Secands

Lor® iB Lon' [33

< i — |

R SN e = T - = R

Figure 39: Calibrating a Map Using Calibration Tool (position 3)

Following these steps the map is now calibrated and can be used with u-center for visualizing road tests etc.
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4.5.12 Sky View

Sky View is an excellent tool for analyzing the performance of antennas as well as the conditions of the satellite
observation environment. The polar plot graphically displays the averaged relative satellite signal strength (Figure
40), the position of satellites in the sky, identifies satellites by number and indicates which satellites are being
used in the receiver calculation (see Section 3.1). Right-clicking the mouse on Sky View allows the copying of
C/No values in tabular form to another program.

& D ke §

Figure 40: Sky View

Element Name Description

Linear Selects a linear projection of the Sky View
Sine Selects a sinusoidal Projection of the Sky View
& C/No Displays the averaged C/No values

(=) Orbits Displays the orbits of the satellites

¥ SVs Displays the current position of the satellites
wEE Coord. Adds a caption for the azimuth

i Elevation Adds a caption for the elevation

Table 9: Description of the toolbar in Sky View
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4.6 Receiver Menu and Receiver Toolbar

File Edit ‘iew Playver Tools  Window

Part b—lE— o -

Baudrate — nr -
UDP Client...

TCP Cliert ..

Recent Connections  »

Autobauding

u-blox 5 Mode

action [ 2

Figure 41: Receiver Menu with corresponding icons from Receiver Toolbar

In order to communicate with a GPS receiver, u-center must have the correct COM port settings. Please refer to
Section 2.4 for a description of the settings.

& Only the COM Ports, that are available on your computer, will show up in the COM Port drop down list. If
a COM Port is grayed out, another application on the computer is using it.

4.7 Action Toolbar and Menu

File Edit Yiew Player | Receiver Tools Window Help

ohs . E Part 2
J D GD Ik Baudrate LS
| = e o[ UDP Clert... AHE|IL|® (DB -

J | ! TP Client ..,

Recent Conmechons: b

Autabauding
bl 5 Mode
cotat
W armishart
Hakskark

Assisthow Onling

Save Config
Load Config
Feewert Config

[ B0 v e f@

The Action toolbar and menu are used to command the receiver to perform a Cold-, Warm- or Hotstarts, or to
implement the AssistNow Online Aiding (A-GPS) function. More information about AssistNow Online is available
from our website at: http://Awww.u-blox.com/services/assistnow_online.html. In order to take advantage of
AssistNow Online, customers must register with u-blox. Please contact your nearest u-blox sales office to get
access details.
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4.8 AssistNow Offline Toolbar and Menu

335“

File Edit Wiew Plaver

Firrmware pdate Ankaris ...

Firmware pdate u-bloxs, ..

Durnp Receiver Diagnostics. ..
FFline. ..

GPS Configuration. ..

Hotkeys ..
Preferences. ..

The AssistNow Offline Toolbar and menu is used to download AlmanacPlus aiding data for A-GPS. AlmanacPlus
data files are available in various sizes to provide aiding for periods of 1 to 14 days. More information about
AssistNow Offline is available from our website at: http://www.u-blox.com/services/assistnow_offline.html.

4.9 Player Menu and Player Toolbar

2am oD -» K I _e

Eiect Crl+E —
v Skop Ckrl+H [}
Pause Chrl+P
Record Chrl+R .
Step Ctr4+Space ———|p Slaw
p|a.:',. Chel+G [ETTTTTTTTTLT PP TTT PP PP rrY ﬂljfl'l'lEl' | h w2
SCan ChH+F — East
aato Begin K-
Goko End —=H

Goto Position |

The primary function of the Player is to display previously recorded GPS data from a file. Refer to Section4.3 for a
description on how to create or open a log file. Using the player controls, you can step through or play all
messages from the log file. The series of buttons in the player toolbar can be used to navigate through the log
file. The records will be displayed on the navigation display window, in the same way that live GPS data is
displayed when using u-center. The current file that is being displayed is shown in the box “File in use”.
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Element Name Description
Y Eject Close the active log file
| Stop Stops displaying or recording to the active log file
Pause Pauses displaying or recording to a log file
& Record Starts recording to the previously created logdfile. Please note this function is only
available if a logfile has been opened before.
I Step Single step function, the next message is read
- Play Starts to display a log file. You can select the speed of the action. After each
message the display is updated as required
19 Scan Reads the entire log file into the database and updates the display at the end of
the scan period
M- Go to Begin Set the read path to the begin of the log file
= Go to End Go to the end of the log file
i Go to Position This slider bar is used to shuttle back and forth through the history log. Pulling
the slider to the right will fast-forward the playback, and pulling it to the left will
rewind the playback

Table 10: Description of the buttons and the slider in the Player Toolbar

4.10View Menu: Docking Windows

The Docking Windows are graphic displays, which provide real-time information about the GPS receiver. These
are the most commonly used windows for u-center users. Eight different panes can be displayed: receiver status,
satellite and signal strength information, position on a world map and 4 analog dials. The windows can be
resized, closed or moved anywhere on the screen. Refer to Section 3.1 for an explanation about the color codes.

To open these windows, select Docking Windows from the View menu, or simply click on the icons on the

View tool bar.

v Satellite Paosition
v Satellite Level

v \world Position
v Daka

v Altitude Meker
v Compass

v Speed Meter
v Watch
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Satellite Level

Displays Elevation,
Azimuth and C/NO
(dBHz) for SVs

World Position
Displays the current
Position on a world
map

Receiver Status
Displays a summary
of the receiver
status.

Figure 42: Docking Windows

4.11Tools Menu

4.11.1 Firmware Update (u-blox 5)

u-center - User's Guide

Satellite Position
Displays the position
of satellites in the
sky

Speed Meter

Displays the current
speed

Compass

Displays the current
course over ground

Altitude Meter

Displays the current
altitude

m Watch

Displays the date
and the current
UTC-Time

The receiver firmware can be updated with the firmware update function in the Tools Menu.

Establish the serial communication between u-center and the GPS receiver (see also section 2.4).

Start the Firmware update tool under u-center menu "Tools" and then "Firmware update u-blox 5”.

Select the path of the Firmware image and Flash definition file (see Figure 43)

Select the update mode "ROM3 over USB" if you're using the USB port or "Enter Safeboot before update”

with USART.
Select the download baudrate. etc.

Select "Erase whole Flash" only if you want to delete all stored configuration and factory settings.

u-blox5 Flash Firmware Update _&

Firtnware image

IC:'\ubIDxE\Fi rrrwvareubloxE_Py 5.00_LEA-SH_with_FOk 3 hin

Flash definition file
IC:\ubonE‘-,u—center'\flash.b:t

[v Use this Baudrate for update
115200

v ROM3 over USE (no Hub)

vI [T EnterSafebontbefare update

¥ Clear BER: befare ipdate

[+ Erase whole Flash Ok | Cancel
Figure 43: u-blox 5 Firmware update window
GPS-SW-08007-A Released
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4.11.2 Firmware Update (ANTARIS 4)

The

receiver firmware can be updated with the firmware update function in the Tools Menu.

Establish the serial communication between u-center and the GPS receiver (see also section 2.4).
Start the Firmware Update Tool
Select the path of the ‘prodstub’ (ATR0620l.exe) and the firmware image.

Select the ‘Production Mode’. ANTARIS® based GPS receivers can be put into boot mode by sending a UBX
protocol command. If the GPS receiver connected to u-center is configured for UBX protocol input, choose
the ‘use serial port’ option. Otherwise, select ‘use bootmode pin’ and put the receiver manually into boot
mode.

Check the COM port (u-center automatically initializes the COM port with the u-center COM port).

Select the download baudrate. This is the baudrate used during the firmware download. The default value is
115200 baud. The lower this baudrate, the longer a firmware update takes.

If ‘Production Mode’ is set to ‘serial port with UBX protocol’, check the UBX protocol baudrate( u-center
automatically initializes it with the u-center baudrate.). The UBX protocol baudrate is only used to enter the
download process.

Initiate the download by pressing the ‘Update’ button. The GPS receiver will be reset automatically after the
download.

AMTARIS Flash Firmware Update E |

Firrmware image

uc-timlphdebors flashrun, bin j _I

Prodztub lozation

T

T:

Senal interface part IEEIM'I "l at baudrate |1'|52E|D "I

To enter Production Mode:

r

r

\uc_v2_ldhATROB20] exe _|

uze bootmode pin [on GPS evaluation bow: press boot button while
cycling power or pressing the reset button, then start the update]

uze BTS /DR [make sure that the jumpere inthe GRS evaluation
b are inthe carrect pasition]

¥ uge zenial port with UB3 protocal at baudrate IE?‘EDD 'I
Frogress

pdate Abart

Figure 44: ANTARIS Firmware update window
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4.11.3 Dump Receiver Diagnostics

3

|1z thiz tool to dump diagnostic information booa
file if u-blox suppart requests vou to do so for
additional info on a bug repaort

Dump Receiver Info to File

Diagrnostics oukput file:
C:hdiagnostic. ubs |:|

Cancel |

4.11.4 GPS Configuration

u-center is capable of getting the actual configuration of a u-blox GPS receiver and storing it to an ASCII text file
containing hexadecimal records. Such a file can be edited and stored to an u-blox GPS receiver again. By clicking
the menu “Tools->GPS Configuration..” of u-center, the GPS Configuration dialog opens. The following
functions are available:

GPS Configuration r5_<|

Configuration file:

Files\w-blox'u-centersCanfigDief. xRS |

[ Store configuration intoBBR /Flazh
[hon-wolatile mermary)

Retries [for every meszage): 1 _I;l

GPS 2 File

Cloze

Figure 45: Screenshot, u-center GPS configuration

o Specify the name of a new configuration file to store current configuration from the u-blox GPS receiver

o Specify the name of an existing configuration file and load this configuration into the u-blox GPS receiver

» Aflag can be set to force storing the configuration into the Battery Backed RAM (BBR) or Flash EPROM.

If reading or writing configuration data fails too frequently, try to increase the number of retries u-center should
do on a single message if one fails.

& Sending a configuration to a u-blox GPS receiver may fail due to a baud rate change on the current serial
port of the receiver where sending this configuration to. If this happens, simply change the u-center baud
rate and send the configuration again.

A window shows the progress of data transfer to/from u-blox GPS receivers. Clicking “GPS >> File” closes this
dialog box and opens the progress window showing configurations being polled and stored into a local file.

GPS-SW-08007-A Released Menu Structure
Page 47 of 57



@b I Ox u-center - User’s Guide

Clicking “File >> GPS" opens the same progress window showing the configurations that are sent to the
receiver. This progress window closes after having finished transfer without any error.

The user can abort the transfer by clicking the “Abort” button. It's not possible to close the window unless
transfer has completed or the user aborted it.

& It is not recommended to read/write configuration while the GPS receiver is in sleep mode.

& ConfigTest.txt - Notepad [_ O] <]
File Edit Faormat Help

MON-UER - BA B4 28 8@ 32 2E 31 52 43 34 28 280 4D 61 79 28 31 36 20 32 308 38 33 28 :I
CFE-ANT - 86 13 ©4 00 BB B8 BF 64

CFG-DAT - B6 B6 02 06 B8 A6

CFE-INF - 86 B2 08 00 60 00 B0 B0 00 00 O7 00

CFE-INF - 86 62 88 60 OF A2 40 BF 60 60 80 68
lcFE-MSE - 86 01 06 60 61 01 60 06 60 00

CFG-MSG - 86 61 86 00 F1 04 60 60 00 68

CFG-MAU - 86 83 1C 66 A3 01 18 1C 1C 65 B8 3C 3C 14 E8 83 86 06 A5 17 C8 66 C8 68
CFG-PRT - 86 68 14 00 60 00 60 060 00 60 B0 60 60 08 60 0@ 60 00 60 00 60 60 00 @0
CFG-PRT - 86 60 14 06 A1 06 OB 66 DA 68 GG 6@ 80 25 A0 AP A7 06 A3 0A NG BA A 68
CFG-PRT - 86 68 14 00 B2 00 60 60 DO 68 00 60 60 E1 60 08 67 00 63 00 60 00 00 @0
CFG-RATE - 86 ©8 B6 A0 EB 83 81 80 60 A

CFG-RXHM - 86 11 62 00 68 0@

CFG-TH - @86 10 BC 80 1F 60 66 AG E8 A3 O 6@ 68 A0 B8 A0

CFG-TP - @86 O7 14 680 40 42 OF 60 AQ 86 01 60 61 61 60 00 32 60 34 63 08 60 00 00

4 | Wl

Figure 46: Content Configuration File

When clicking the “Edit” button in the GPS Configuration dialog, the Notepad editor opens (standard Windows
software). Configurations are stored the following way:

1* line: it contains the version of the ANTARIS® based GPS receiver where the configuration is from. Never
change this line!

For the 2™ line and following each line contains the same: <class ID>-<message ID> - <hexadecimal byte
code of the message>. The byte code consists of class and message IDs (2 bytes), payload length (2 bytes),
payload (payload length bytes). The sync characters and the checksum are not included. They will be
calculated automatically.

Please refer to ANTARIS® Protocol Specification [8] for detailed information and ranges.

4.11.5 Hotkeys

The Tools Menu allows administrating the Hotkeys defined in the Message View. Please refer to Section 4.5.4 for
more information on the Hotkeys.

4.11.6 Preferences

The Preferences tool can be used to configure a number of u-center parameters.
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Generic ]Workspace] Colars ] Messagebox]

Sernial ports
v autormatically [dislconnect if most recently used senial port [dizlappears.

[v Erumerate seral ports (this may slow down menus).

b aximum number of zenal ports 255Q
Power Management
* Wone © Deny suspend if connected " Disconnect on suspend

Program Options [requires restart]

£y

Database

b awimum nurnber of epochs = 00:30:00 at 1Hz rate

Cancel

4.12Windows Menu

The Windows Menu is Windows® compliant.
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5 How To

5.1 Change Parameters (Baudrate)

e Connect to receiver.
e Open Message View.
o Select UBX — CFG - PRT

3 Messages - UBX - CFG (Config) - PRT (Ports)

= = B - CFG [Config) - PRT [Ports]

* Tanget [1-UaRTY -l

Protocalin  |0+1+2 - UBX+NMEA+RT = |
Protocol out |0+1 - UBK+MMEA, |

Baudrate

o000 BS 62 06 00 14 00 01 00 00 00 DO 03 nphi0000000b0O
0g0oc 00 90 00 EL 00 00 97 00 03 00 00 00 00000000000
0018 00 00 DE C2 OOBE

][] [+

GPS-SW-08007-A Released How To
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5.2 Save Parameters to receiver non-volatile memory (BBR/Flash)

There are 2 ways to save parameters to the receiver’s non-volatile memory (BBR/Flash).

5.2.1 Saving Parameters with UBX-CFG-CFG

e Connect to receiver.

e Open Message View.

e Select UBX-CFG-CFG window.

o Select “save current configuration” (see Figure 47).

[ Messages - UBX - CFG (Config) - CFG (Configuration)

BX

— | UBx - CFG [Config] - CFG [Configuration]

" Revert to last saved configuration v Devices (»Fam3)
" Revert to default configuration
+ Save cunent configuration

" User defined operation

Clear Save Load

: 0000 B5 62 06 09 0D OO OO0 OO 0O 00 FF FF  pbO000000O0%
gooc 00 00 00 00 00 00 o7 21 AF [ ]m]mm[m[mm A

[IE.4

@ X 3 eH

Figure 47: Saving Parameters (UBX-CFG-CFG)

5.2.2 Saving Parameters with GPS Configuration

Connect to receiver.

Open Tools / GPS Configuration.

Select “store configuration into BBR/Flash” checkbox (see Figure 48).

& This only applies when sending configuration files to the receiver.
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File Edit W%iew Player FReceiver | Tools “Window Help

Firrware pdate Antaris ...
Firmware pdate u-bloxs. ..

AlmanacFlus. ..
; nfiguration. ..

Hothews ...
Preferences. ..

GPS Configuration |

Canfiguratian file:

| =L

Stare configuration intoBER /Flazh
[hon-wolatile memary]

Retries [for every meszage): I 'I_IZ:I

GPS>>Fie [ Edi. |

Fiess 6P [ [ Ciose |

Figure 48: Saving Parameters (GPS Configuration)

5.3 Recording/Playing a Log File

u-center allows recording and playing log files. Use the player controls, to record or playback a log file. Select the
log file to be opened through the File Menu tool bar. The series of buttons in the player toolbar can be used to
navigate through the log file. The records will be displayed on the navigation display window, in the same way
that live GPS data is displayed when using u-center.

[2m oD -» K [ H

Eject Chrl+E =
v Skop CErl+H ]
Pause Chrl+P
Record Chrl+R .
Skep Ctrl+Space ——— ¢ Slow
F'IEI';." 43 [ETTTTTTTTTLT PP TTT PP PP rrY HD[ITIE' | b W
Scan Zkrl+F [ 2 Fast
aato Begin K
Goko End —=H

Figure 49: u-center player toolbar

New log files can also be created through the menu bar by selecting File/New. Figure 50 shows an example of a
log file.
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Save Chrl+s
Open... e N TR S S
Close

Database Emply

Database Export

Prink... Chrl+P
Print Presview
Print Setup...

Recent Files

Exit

Save in: I&)meTMP j - £ B

[@] Unitled_naos11_140500.ubx
@ COMS _ref,ubx
[ @] com4_kerlink. ubic

My Network File name: I::IZII--H 0
Places

Save as type: Iu-b\ox Log Files [*.ubx]

Figure 50: Example of a Log File

5.4 Conduct Sensitivity Tests

u-center is a useful tool for conducting sensitivity tests of GPS receivers and receiver designs. To do so record a
log file under open sky conditions of the receiver to be tested and an Evaluation Kit as reference. Make sure that
the log files are recorded under the same conditions. Using the Statistic View or Table View windows from
u-center, compare the C/NO values of the five strongest satellites. When using Table view, export the values to a
spreadsheet for analysis.
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5.5 Read/Write Configuration Files

Connect to receiver.

Open Tools / GPS Configuration.

select the name of the configuration file to be read or written.

o Select "File>>GPS” button to read or”GPS>>File” to write configuration files.

File Edit Wiew Player Receiver | Tools Window Help
Firrmware pdate Antaris ...
Firmware pdate u-bloxs, .,
AlmanacPus. ..

I nfiguratian. ..

Hotkeys ...
Freferences. .,
GPS Configuration
Canfiguration fils:
Iconfig.txt ;l _I
¥ Stare configuration intoBER /Flash
[non-walatle memory)
Fietries [for even message]: I 1_|:
—
(orsFie D Ear. |
File > GPS Close |
GPS-SW-08007-A Released How To
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6 Troubleshooting

NMEA or UBX protocol is not available in the Message View

u-center uses dynamic link libraries (DLL). The installation program will automatically install the required DLL's
into the u-center program directory. Should you try to copy a u-center installation from one location to another,
make sure you also copy the DLL files. Verify, the version of u-center matches the DLL version.

u-center doesn’t display all messages

Make sure the baudrate is sufficient. If the bandwidth is insufficient, GPS receivers based on the ANTARIS™ GPS
Technology will skip excessive messages.

Some serial port cards/adapters (i.e. USB to RS232 converter) frequently generate errors. If a communication
error occurs during while u-center receives a message, the message will be discarded.

u-center loses the connection to the GPS receiver

u-center u-blox GPS receivers have an autobauding feature. If frequent communication errors occur (i.e. due to
problems with the serial port), the connection may be lost as u-center and the GPS receiver will autonomously
try to adjust the baudrate. Do not enable the u-center autobauding feature if the GPS receiver has the
autobauding enabled.

Some COM port are not shown in the port list

Only the COM Ports, that are available on your computer, will show up in the COM Port drop down list. If a
COM Port is grayed out, another application in the computer is using it.

PCis very slow when u-center runs

If a high value of epochs is selected, the display in real-time can not be guaranteed, especially when many
graphical Views are open. u-center does not update minimized Views and Console in real-time. Close or
minimize as many of the graphical Views and Consoles as possible and u-center will run faster.

Logfile / Data are only partly displayed

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of larger logfiles. The
limitation is set to 1800 epochs by default. That means if an epoch is available every second you can analyze
data for as much as 30 minutes. After this time the oldest values are discarded. Data stored to a logfile are not
affected by the database limitation. Please refer to section 3.2.5 Database Limitation for instructions on how to
increase this limit.

When planning long-term observations, it's recommended to start recording a log file before analysis begins.

Output messages are not updated in the Message View

Make sure, the protocol you'd like to receive is enabled. If so, double-click on the desired output message.
Double-clicking on an output message enables or disables the periodic message update if the respective protocol
is active. Alternatively, select the desired input or output message and press the ‘Poll” button.

If you would like to get UBX-INF () messages in the log file, configure the receiver accordingly with the UBX-CFG-
INF input message.

No logfile is recorded

After a new logfile is created, logging will not automatically start but only after selecting the Record button in
the Player Toolbar.
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Related Documents

[1] GPS Compendium, Doc No GPS-X-02007
(2] u-blox 5 Receiver Description including Protocol Specification, Docu. No GPS.G5-X-07036

All these documents are available on our website (www.u-blox.com).

& For regular updates to u-blox documentation and to receive product change notifications please register
on our homepage.

Revision history

Status / Comments

Revision Date Name

- 08/10/2008 tgri Initial release

A 22/07/2009 tgri New ClI
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Contact

For complete contact information visit us at www.u-blox.com

Offices

North, Central and South America

u-blox America, Inc.

Phone: +1(703) 483 3180
E-mail: info_us@u-blox.com

Regional Office West Coast:

Phone: +1(703) 483 3184
E-mail: info_us@u-blox.com

Technical Support:

Phone: +1(703) 483 3185
E-mail: support_us@u-blox.com

GPS-SW-08007-A

Headquarters
Europe, Middle East, Africa

u-blox AG

Phone: +41 44 722 74 44
E-mail: info@u-blox.com

Technical Support:

Phone: +4144 722 74 44
E-mail: support@u-blox.com
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Asia, Australia, Pacific

u-blox Singapore Pte. Ltd.

Phone: +65 6734 3811

E-mail: info_ap@u-blox.com
Support:  support_ap@u-blox.com

Regional Office China:

Phone: +86 10 68 133 545
E-mail: info_cn@u-blox.com
Support:  support_cn@u-blox.com

Regional Office Japan:

Phone: +81 3 4360 5343
E-mail: info_jp@u-blox.com
Support:  support_jp@u-blox.com

Regional Office Korea:

Phone: +82 2 542 0861

E-mail: info_kr@u-blox.com
Support:  support_kr@u-blox.com

Regional Office Taiwan:

Phone: +886 2 2657 1090
E-mail: info_tw@u-blox.com
Support:  support_tw@u-blox.com

Contact
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